Welcome

Avenza welcomes you to mapmaking in the 21st century!

Combined with Adobe Illustrator, MAPublisher has revolutionized the art of mapmaking by allowing spatial data files to be used to create maps inside a vector graphics program. MAPublisher allows all your cartographic tasks to be performed where they should be done; in a powerful graphics environment.

MAPublisher LabelPro™ revolutionizes the way users can label map data, including using symbols as labels, conflict resolution, and highly configurable rule-based labeling options. The MAP LabelPro engine uses map data attributes for labeling with styles, rules and controls configured through an intuitive, easy-to-use Graphical User Interface.

This tutorial assumes that the user is familiar with Adobe Illustrator CS6/CC/CC 2014, and has at least a basic understanding of MAPublisher tools and features. Not all MAPublisher tools are explained in this document. This tutorial should be used in conjunction with the MAPublisher 9.5 User Guide, MAPublisher 9.5 Tutorial Guide and Quick Start Guide for an understanding of all the other MAPublisher tools.

By following this tutorial, you will learn how to setup and use the MAP LabelPro labeling engine to label your map created in MAPublisher. Working on a provided map, users learn to create rules and styles for labeling in an automated and efficient way.

MAP LabelPro Tutorial Data

This tutorial will use Adobe Illustrator files and MAP LabelPro rules installed with MAPublisher 9.5. You can find the MAP LabelPro Tutorial data in the following location on your hard drive:

**Windows 7 / 8**
C:\Users\Public\Public Documents\Avenza\MAPublisher 9.5\MAP LabelPro Tutorial & Data\Data

**Note:** This data may be accessed through shortcuts available in the Windows start menu.

**Mac OS X**
/Applications/Avenza/MAPublisher 9.5/MAPublisher Tutorials/MAP LabelPro Tutorial & Data/Data

You are encouraged to experiment with your own data to gain additional experience with MAPublisher tools.

Tutorial data courtesy of City and County of San Francisco (San Francisco Enterprise GIS program SFGIS).
# Contents

**Welcome**

**Contents**

1 Preliminaries
   1.1 Purpose .................................................................................................. 5
   1.2 Know your data ........................................................................................ 5
      1.2.1 San Francisco map description ......................................................... 5
      1.2.2 Styles and rules ............................................................................... 6
      1.2.3 Important note for MAPublisher LabelPro evaluation users .............. 6

2 Getting Started
   2.1 Open tutorial document ................................................................. 7
   2.2 Examine MAP Attributes available for labeling ............................. 7

3 Labeling Session #1
   3.1 Layers and obstacles setup .............................................................. 10
   3.2 Labeling extents setup .................................................................... 11
   3.3 Point layer label settings ............................................................... 12
   3.4 Line layers label settings ............................................................... 14
      3.4.1 Label lines with symbols ............................................................... 14
      3.4.2 Label lines with text only ............................................................. 16
   3.5 Area layer label settings ............................................................... 18
   3.6 Execute labeling with MAP LabelPro ............................................ 19

4 Labeling Session #2
   4.1 Layers and obstacles setup .............................................................. 21
   4.2 Create Label filters .......................................................................... 22
   4.3 Create styles and rules .................................................................... 23
   4.4 Execute labeling with MAP LabelPro ............................................ 25
1 Preliminaries

1.1 Purpose

The purpose of this exercise is to use MAP LabelPro to create labels for a simple map of downtown San Francisco, California, USA. For this exercise, Avenza has prepared the necessary map file created with MAPublisher 9.5 and Adobe Illustrator, based on City and County of San Francisco GIS data (San Francisco Enterprise GIS program SFGIS). The map contains all the different type of features (point, line and area) for labeling and obstacle purpose.

In this exercise, you will start by preparing the file and examining the data to familiarize yourself with the prerequisites to using MAP LabelPro. Then, the labeling will be done in two steps: a main labeling session (labeling public schools, streets, interstates, highways and land areas in one run) and a secondary session (labeling parks only, using the other labels as obstacles). Although the presented settings are valid only for the map data they are based on, the principles are applicable for your own designs.

1.2 Know your data

The MAP LabelPro Tutorial data folder contains a ready-to-use Adobe Illustrator template file containing a map of downtown San Francisco (MAPLabelPro_Tutorial.ait). Here is a description of the layers present in the file and how they will be used during the labeling process.

1.2.1 San Francisco map description

<table>
<thead>
<tr>
<th>Layer name</th>
<th>Type</th>
<th>Description</th>
<th>Labeling Attribute (label source layers)</th>
<th>Obstacle?</th>
<th>Session #1</th>
<th>Session #2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Text layers</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAND_labels</td>
<td>Text</td>
<td>Land labels</td>
<td>-</td>
<td>-</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>SCHOOL_labels</td>
<td>Text</td>
<td>School labels</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>STREET_labels</td>
<td>Text</td>
<td>Street labels</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>PARK_labels</td>
<td>Text</td>
<td>Park labels</td>
<td>-</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HIGHWAY_INTERSTATE_labels</td>
<td>Text</td>
<td>Labels for highways and interstates</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>SUPPRESSED_labels</td>
<td>Text</td>
<td>Labels that couldn't be placed based on the specified rules.</td>
<td>-</td>
<td>-</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>MAP_TITLE</td>
<td>Text</td>
<td>Map title (San Francisco)</td>
<td>-</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td><strong>MAP Layers</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Public_Schools_point</td>
<td>Point</td>
<td>Public school locations</td>
<td>SCHOOL_NAME</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Post_Offices_point</td>
<td>Point</td>
<td>Post office locations</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Highways_line</td>
<td>Line</td>
<td>Highway roads</td>
<td>HIGHWAY_NUMBER</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Interstates_line</td>
<td>Line</td>
<td>Interstate roads</td>
<td>INTERSTATE_NUMBER</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Ramp_line</td>
<td>Line</td>
<td>Ramps to highways</td>
<td>-</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Streets_line</td>
<td>Line</td>
<td>San Francisco street network</td>
<td>STREETNAME</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Land_area</td>
<td>Area</td>
<td>Land areas</td>
<td>AREA_NAME</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Parks_area</td>
<td>Area</td>
<td>Park areas</td>
<td>PARK_NAME</td>
<td>Yes</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>
1 Preliminaries

<table>
<thead>
<tr>
<th>Layer name</th>
<th>Type</th>
<th>Description</th>
<th>Labeling Attribute (label source layers)</th>
<th>Obstacle?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other Layers</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale_Bar</td>
<td>Legend</td>
<td>Scale bar</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>background</td>
<td>Area</td>
<td>Blue background to represent the sea</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

All map layers were imported from City and County of San Francisco GIS data (San Francisco Enterprise GIS program SFGIS) in ESRI shapefile format and cropped to the area of interest. The map design (symbols and line styles) was created by Avenza Systems.

1.2.2 Styles and rules

MAPublisher is installed with predefined styles and rules to use for the MAP LabelPro settings in this tutorial. These configuration files are saved to one of three folders depending on the data type layer, Area, Line or Point, they are associated with.

<table>
<thead>
<tr>
<th>Layer Name</th>
<th>Type</th>
<th>Style</th>
<th>Rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public_Schools_point</td>
<td>Point</td>
<td>School_Label_Style</td>
<td>School_Label_Rule</td>
</tr>
<tr>
<td>Interstates_line</td>
<td>Line</td>
<td>Interstate_Label_Style</td>
<td>Interstate_Label_Rule</td>
</tr>
<tr>
<td>Highways_line</td>
<td>Line</td>
<td>Highway_Label_Style</td>
<td>Highway_Label_Rule</td>
</tr>
<tr>
<td>Streets_line</td>
<td>Line</td>
<td>Street_Label Style</td>
<td>Street_Label Rule</td>
</tr>
<tr>
<td>Parks_area</td>
<td>Area</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Land_area</td>
<td>Area</td>
<td>Land_Label_Style</td>
<td>Land_Label_Rule</td>
</tr>
</tbody>
</table>

The style and rules for the Parks_area layer will be created during the second labeling session of this exercise.

The default location of the Rules and Styles folders is:

Windows 7/8: C:\ProgramData\Avenza\MAPublisher 9\LabelPro\Rules
Mac OS X: Applications/Avenza/MAPublisher 9.5/LabelPro/LabelPro/Rules

Note: The MAP LabelPro tutorial data folder also contains a backup for these rules and styles

1.2.3 Important note for MAPublisher LabelPro evaluation users

The evaluation version of MAPublisher LabelPro scrambles the text of placed labels but preserves the case, spacing and punctuation so that it simulates how actual labels would be placed. Therefore, evaluation users will experience a different result with the MAP LabelPro settings of this tutorial than licensed users. The results will be shown and differences explained at the end of this guide. In evaluation mode, the scrambling process noticeably slows the speed of labeling.
2  Getting Started

2.1  Open tutorial document

1. In the Adobe Illustrator main menu, choose File > Open and open the template file MAPLabelPro_Tutorial.ait located in \MAPublisher 9.5\MAP LabelPro Tutorial Guide & Data\Data.

An artboard containing a map of San Francisco opens. All the data information to be used for labeling is present, except for the text labels. Please see the table in the Preliminaries chapter for the description of the layers.

2. Because the file was opened from a template, a new untitled document was created. Choose from the Adobe Illustrator main menu File > Save As to save the file as San Francisco.ai.

   Note: Customize the Adobe Illustrator workspace to make it easier to access panels. It may look different than the image above. Read Customizing the workspace in the Adobe Illustrator help guide for more information. Review also MAPublisher Preferences in the MAPublisher 9.5 User Guide.

2.2  Examine MAP Attributes available for labeling

MAP LabelPro extracts label data from the attribute table for each MAP Layer to be labeled. Therefore, it is good practice and often required to examine or edit attribute information using the MAP Attributes panel. Edits can include: creating a new column to enter attribute values, joining tables to import additional attribute information from an external file, correcting spelling, changing the case of text and more.

For this exercise, all attributes are ready to use for labeling. Follow the steps here to examine them and familiarize yourself with the data.

   Note: For more information on the MAP Attributes panel, please refer to the MAPublisher 9.5 User Guide, chapter 5. For more exercises, please see the MAPublisher Quick Start Guide and MAPublisher Tutorial Guide.

1. In the Adobe Illustrator Layers panel, click the target button next to the Public_Schools_point layer to select all artwork on the layer.
2. Open the MAP Attributes panel (from the Adobe Illustrator main menu, choose Window > MAPublisher > MAP Attributes or click the MAP Attributes button on the MAPublisher toolbar).

The Public_Schools_point layer contains four visible attribute columns: OBJECTID, FACILITY_I, DEPTNAME and SCHOOL_NAME. The SCHOOL_NAME attribute column will be used for labeling the school points.

3. Select all artwork on the Interstates_Line layer and view the attributes in the MAP Attributes panel.

The INTERSTATE_NUMBER attribute column will be used for labeling these roads.

Note: Notice that the INTERSTATE_NUMBER attribute is of type integer. All types of attributes may be used for labeling with MAP LabelPro.

4. Select all on the Highways_line layer and view the attributes in the MAP Attributes panel. HIGHWAY_NUMBER will be used for labeling. View the attributes of the remaining layers: Streets_line, Parks_area, and Land_area.

Refer to the San Francisco description table in section 1.2.1 to see the attributes that will be used for labeling.

5. Close the MAP Attributes panel after reviewing it.

Knowing this information, we are ready to use the MAP LabelPro function to generate map labels for the San Francisco downtown map.
3 Labeling Session #1

In this first labeling session, multiple layers will be labeled in a single run of MAP LabelPro. The objectives for this session are to:

- Add labels for school as a first priority (source layer `Public_Schools_point`).
- Label the interstate roads with interstate shield symbols containing the interstate number (source layer `Interstates_line`).
- Label the highway roads with highway shield symbols containing the highway number (source layer `Highways_line`).
- Add street names (source layer `Streets_line`).
- Add names for land areas, written in the sea to make the map more readable (source layer `Land_area`).
- Make sure that the school and road names do not overlap with the post office and school symbols and park area, and do not cross highways and interstates line (obstacle layers: `Post_Offices_point`, `Public_Schools_point`, `Parks_area`, `Interstates_line` and `Highways_line`).

To start the MAP LabelPro Editor, click the MAP LabelPro button on the MAPublisher Toolbar.

The MAP LabelPro dialog box opens.

All layers have to be configured before labeling with MAP LabelPro. The general MAP LabelPro workflow: setup layers, specify attribute label source, set label output layer and suppression layers, set label priority, and define layer styles and rules.

**Note:** If the dialog box needs to be closed before all settings are done, make sure to click the Save button.
3.1 Layers and obstacles setup

1. In the MAP LabelPro editor dialog box, click the Setup Layers button.
2. In the Setup Layers dialog box, click the check box in the Show column for each of the following layers:
   - MAP_TITLE
   - Post_Offices_point
   - Public_Schools_point
   - Highways_line
   - Interstates_line
   - Streets_line
   - Land_area
   - Parks_area

3. Make sure that the settings match the image above and click OK.

The MAP LabelPro dialog box displays the MAP View and chosen layers. Layers can be designated for labeling and obstacles in the list by clicking the appropriate column.
4. The first layer in the Source list, MAP_TITLE, will be designated as an obstacle. Click the corresponding spot in the Obstacle column.

![Image of the SetupLayers dialog box with selected layers and check boxes]

Notice that the Is obstacle check box is also checked, indicating that it is designated as an obstacle. An obstacle is an object that impedes the placement of a label. See chapter 17 of the MAPublisher User Guide.

5. Now designate the other layers as labeled or an obstacle by clicking the appropriate column:

- **Labeled**
  - Public_Schools_point
  - Highways_line
  - Interstates_line
  - Streets_line
  - Land_area

- **Obstacle**
  - Post_Offices_point
  - Public_Schools_point
  - Highways_line
  - Interstates_line
  - Parks_area

### 3.2 Labeling extents setup

The configuration described in this exercise will limit the creation of labels to the extent of the selected source layers for labeling, with a margin of 0.2 inches on each side.

1. Click the Advanced button in the MAP LabelPro dialog box.
2. Under Label Placement Area, choose the Extents of labeled layers option.
3. Click the Label Margins check box. Set the Top, Left, Right and Bottom drop-down lists to 0.20 in.

**Note:** If the option *Paths without stroke are not considered obstacles* is checked, areas that have no stroke will not be used as an obstacle in the labeling process, allowing generated labels to overlap with them.

4. Make sure that the settings match the image above and click OK.

The label styles and rules of each source layer are now ready to be set.
3.3 Point layer label settings

1. In the MAP LabelPro editor dialog box, click Public_Schools_point in the Source list to highlight the row.

   By default, the attribute to use as a label is set to FACILITY_I, the first string attribute column of the Public_Schools_point layer. It needs to be changed to SCHOOL_NAME.

   **Note:** Increase the width of an attribute column to see its full name.

2. Click the Label source drop-down list and choose SCHOOL_NAME.
3. Click the Output layer drop-down list and choose SCHOOL_labels.

   Leave the Priority column set to 1. The Public_Schools_point layer will be labeled as a first priority while the others will be set to a secondary priority. Next, you'll change the style and rules for this layer.

4. Click the Style drop-down list and choose School_Label_Style. Click the Edit button to open the Style dialog box and examine its settings. This style was predefined for the purpose of the tutorial.

   **Note:** The second labeling session will show how to create a new style from scratch.

5. After reviewing the point Style settings, click OK to close it.
6. Click the Rules drop-down list and choose **School_Label_Rule**. Click the Edit button to open the Point Rules dialog box and examine its rules in each tab. These rules were predefined for the purpose of the tutorial.

   ![Point Rules dialog box](image)

   These point settings will force the labels to be placed below the symbols:
   - When possible, the text will be placed lower-middle to the symbol.
   - If this is not possible due to space constrictions, text will be placed to the lower-right, and then to the lower-left.
   - If none of the options can be applied, the text will be placed on the suppression layer (or ignored if no suppression layer was specified).
   - Text stacking and font reduction have also been enabled to add flexibility to the placement rules.

   **Note:** More information on the available labeling options can be found in the MAPublisher User Guide, chapter 17.

7. After reviewing the Point Rules dialog box, click OK to close it.
8. Click the Suppression layer drop-down list and choose **SUPPRESSED_labels**. (It looks gray because its visibility is toggled off in the Layers panel).

   ![Suppression layer settings](image)

   Labels that can not be placed will be copied to the **SUPPRESSED_labels** layer.
**Note:** Scroll to the right of the MAP LabelPro dialog box or expand it to see the *Suppression Layer* column.

This finalizes the configuration for the labeling of the *Public_Schools_point* layer. **Do not close** the MAP LabelPro dialog box as the configuration of the roads and land layers still have to be set. If you want to save the current configurations, click the *Save* button. You will have to reopen the MAP LabelPro dialog box to continue.

### 3.4 Line layers label settings

This section covers the labeling configuration for the source layers *Highways_line*, *Interstates_line* and *Streets_line*. Highways and interstates will be labeled using highway and interstate symbol shields—notice that these layers contain double-lines for each road (divided highways).

#### 3.4.1 Label lines with symbols

1. In the MAP LabelPro dialog box, click the *Highways_line* layer name in the Source column to highlight the row.
2. Click the Label source drop-down list and choose *HIGHWAY_NUMBER*.
3. Keep the Output layer as the default (*HIGHWAY_INTERSTATE_labels*).
4. Set the Priority to 2.
5. Click the Style drop-down list and choose *Highway_Label_Style*. Click the Edit button to open the Style dialog box and examine its settings. This style was predefined.

In addition to the regular font settings, line labels can also be labeled with symbols. In this case, the Label with symbol option is enabled. Symbol files (*.lsf) contain a series of symbols. In the example above, the *United States Interstate* symbol is selected from the *generic_shields.1sf* symbol file. The symbol size is set to a height of 0.25 inches. The symbol font color is set to white so it can be legible against the blue symbol.

6. After reviewing the Style settings, click OK to close it.
7. Click the Rules drop-down list and choose Highway_Label_Rule. Click the Edit button to open the Line Rules dialog box and examine its settings. These rules were predefined.

With these settings, the highway labels (and shields) will be placed in the middle of each line length and on the centerline, with a font reduction (if necessary). The Divided Highways setting recognizes lines that are parallel and share the same name (as specified by the selected attribute). In such cases, it places only one symbol instead of two or more. The Allow labels to cross lines option needs to be enabled because double highway lines are very close in proximity and the labels need to cross the lines. More information on line labeling rules can be found in the MAPublisher 9.5 User Guide, chapter 17.

Note: Evaluation users will see a different result than a licensed user. Because of the text scrambling, the divided highways cannot be recognized. Here is an example with the interstates:

8. After reviewing the Line Rules settings, click OK to close it.
9. Click the Suppression layer drop-down list and choose SUPPRESSED_labels.
The settings for the *Highways_line* layer are completed. Continue with the settings for the *Interstates_line* layer.

10. Click the *Interstates_line* layer name in the Source column to highlight the row.
11. Click the Label source drop-down list and choose *INTERSTATE_NUMBER*.
12. Keep the destination text layer as the default (*HIGHWAY_INTERSTATE_labels*).
13. Set the Priority column to 2.
14. Click the Style drop-down list and choose *Interstate_Label_Style*. Click the Edit button to open the Style dialog box and examine its settings. This style was predefined.

The United States Route symbol is selected from the *generic_shields.lsf* symbol file. The symbol size is set to a height of 0.25 inches.

15. After reviewing the Style settings, click OK to close it.
16. Click the Rules drop-down list and choose *Interstate_Label_Rule*. Click the Edit button to open the Line Rules dialog box and examine its settings. These rules were predefined.

The labeling rules for the interstates are the same as for the highways. Also, the previous note about text scrambling applies for evaluation users.

17. After reviewing the Line Rules settings, click OK to close it.
18. Click the Suppression layer drop-down list and choose *SUPPRESSED_labels*.

The label settings for the interstate roads are now complete. Continue with setting up street labels.

### 3.4.2 Label lines with text only

1. In the MAP LabelPro dialog box, click the *Streets_line* layer name in the Source column to highlight the row. Keep STREETNAME as the Label source attribute.
2. Click the Output layer drop-down list and choose *STREET_labels*.
3. Set the Priority column to 2.
4. Click the Style drop-down list and choose *Street_Label_Style*. Click the Edit button to open the Style dialog box and examine its settings. This style was predefined.

Notice that this time Label with symbol is not checked.

5. After reviewing the Style settings, click OK to close it.
6. Click the Rules drop-down list and choose \textbf{Street\_Label\_Rule}. Click the Edit button \includegraphics[width=7mm]{edit_icon.png} to open the Line Rules dialog box and examine its settings. These rules were predefined.

Like highway and interstate labels, street labels will be placed in the middle of each line length and on the centerline, with an eventual font reduction if necessary. The ability to overhang is enabled here.

The street lines in this file are not joined. For example, each street is made of many line segments that all share the same STREETNAME attribute. To avoid repeating the name of connecting lines, the Label joined feature rule is enabled. MAP LabelPro recognizes that connecting lines sharing a same name need to be labeled only once.

\textbf{Note: } Evaluation users will see a different result than a licensed user due to the text scrambling. Names are not recognized as being the same and labels will be created for each line segment rather than one per street.

\textbf{Result with license:}\hspace{1cm}\textbf{Result with evaluation:}

7. After reviewing the Line Rules settings, click OK to close it.
8. Click the Suppression layer drop-down list and choose \textbf{SUPPRESSED\_labels}.

This completes the label settings for all line layers. \textbf{Do not close} the MAP LabelPro dialog box as the configuration of the \textit{Land\_area} layer still has to be done. If you want to save the current configurations, click the \textit{Save} button. You will have to reopen the MAP LabelPro dialog box to continue.
3.5 Area layer label settings

This section covers the labeling configuration for the source layers *Land_area*. The goal is to add large labels for the land areas of the map (downtown area, Treasure and Alcatraz Islands).

1. In the MAP LabelPro dialog box, click the *Land_area* layer name in the Source column to highlight the row. Keep AREA_NAME as the Source label attribute.
2. Click the Output layer drop-down list and choose LAND_labels.
3. Set the Priority column to 2.
4. Click the Style drop-down list and choose Land_Label_Style. Click the Edit button to open the Style dialog box and examine its settings. This style was predefined.

**Note:** The sample text is cut off because the font size is set to 70 pt and is larger than the preview area.

5. After reviewing the Style settings, click OK to close it.
6. Click the Rules drop-down list and choose Land_Label_Rule. Click the Edit button to open the Area Rules dialog box and examine its settings. These rules were predefined.

The main requirement for labels created from the *Land_area* layer is that labels are placed in the water area. Therefore, the Allow outside rule is the only placement option enabled. Stacking and font reduction option are also enabled to give more flexibility to the rule. More information on the available area labeling rules can be found in the MAPublisher 9.5 User Guide, chapter 17.

**Note:** Labeling Session #2 will explain the creation of area rules for the Parks_area layer.

7. After reviewing the Area Rules settings, click OK to close it.
8. Click the Suppression layer drop-down list and choose SUPPRESSED_labels.

All layers have been now configured for the first labeling session.
3.6 Execute labeling with MAP LabelPro

1. Make sure that all the layers have been configured to match the image below and click the Label button.

![MAP LabelPro interface]

**Note:** For evaluation users only. Review the MAPublisher warning message and click OK to close it.

2. Wait for the process to end to visualize the results (see next page).

   The map layers are labeled. Make the *SUPPRESSED_labels* layer visible to show labels that couldn’t be placed with the specified rules.

3. Save the file and leave it open to continue on with the second labeling session.
Result with full license:

Result with evaluation license:

Note: Evaluation users will observe scrambled labels on the map. The Label joined feature rule does not recognize similar street names due to the text scrambling and places more labels than necessary. Similarly, highway and interstate roads are labeled with two shields with different numbers. Licensed versions will not see any text scrambling.
4 Labeling Session #2

In this second labeling session, continue with the San Francisco.ai file that you saved. This time, only the parks will be labeled in a single labeling execution of MAP LabelPro. The objectives are to:

- Create a label filter to label small parks and large parks.
- Create new area label styles for small and large parks.
- Create new area label rules for small and large parks.
- Make sure that the park labels do not overlap with the other labels and with the post office and school symbols and do not cross highway and interstate lines.

To start MAP LabelPro, click the **MAP LabelPro** button on the MAPublisher Toolbar. The settings from the previous labeling session are remembered. For the new session, the layer setup has to be changed to match the new objective of this exercise. However, the label extents remain the same as before.

### 4.1 Layers and obstacles setup

1. In the MAP LabelPro dialog box, click the **Setup Layers** button to setup which layers are shown.
2. In the Setup Layers dialog box, click the top **Show** check box (level with San Francisco Downtown MAP View). Click the check box again to uncheck all of the check boxes below. Check only the following layers:
   - **HIGHWAY_INTERSTATE_labels**
   - **SCHOOL_labels**
   - **STREET_labels**
   - **Post_Offices_point**
   - **Public_School_point**
   - **Highways_line**
   - **Interstates_line**
   - **Parks_area**

3. Click **OK** to return to the MAP LabelPro dialog box.
4. Click the **Labeled** icon for the **Parks_area** layer only. Make sure the all remaining layers are set as obstacles:
   - **HIGHWAY_INTERSTATE_labels**
   - **SCHOOL_labels**
   - **STREET_labels**
   - **Post_Offices_point**
   - **Public_School_point**
   - **Highways_line**
   - **Interstates_line**

5. Make sure that the settings match the image above and click **OK**.
4.2 Create Label filters

This section covers the labeling configuration for the source layer Parks_area. The goal is to add labels for small parks and large parks (based on the #Area attribute). This is done by creating Label filters that can isloate and classify data using expressions. In addition, styles and rules will be created from scratch.

1. In the MAP LabelPro dialog box, click the Parks_area layer name in the Source column to highlight the row.
2. Below the Source list, click the Batch generate label filters button.
3. In the Batch Label Filter Generator dialog box, click the Attribute drop-down list and choose #Area, then click the Load button.
4. In the Data Classification section, click the Method drop-down list and choose Natural Breaks (Jenks-Capsall) and change the Data classes to 2.

![Batch Label Filter Generator](image)

Two classes (defined by two generated expressions) will define the small and large parks. The Natural Breaks classification looks for appropriate breaks in the data where to use as data class boundaries. The next step is to set some default settings for the labels (which sets them for both label filters).

5. In the Default Settings section, click the Is labeled check box. Click the Label source drop-down list and choose PARK_NAME. Click the Output layer drop-down list and choose PARK_labels from the drop-down list. Click the Suppression layer drop-down list and choose SUPPRESSED_labels.

![Default Settings](image)

6. Click the Add button to add the two label filters.
4.3 Create styles and rules

1. In the MAP LabelPro dialog box, click the first label filter for the Parks_area layer to highlight it. Change the name of the first label filter to **Small Park**. Click the **Is labeled** check box.

2. Beside the Style drop-down list, click the Edit button to open the Style dialog box.
3. Make sure that **Arial** is selected in the Font family drop-down list and that **Regular** is selected as the Font style.
4. In the Size drop-down list, set the font size to **7.00 pt**
5. Click the color chip and in the Color Picker dialog box, pick dark green color (e.g. R=0, G=85, B=0) and click OK.

6. Click the Save button. In the Save Style As dialog box, type **Small_Park_Style** in the Name box and click Save.

7. In the Style dialog box, click OK.
In the MAP LabelPro dialog box, the Style drop-down list now displays Small_Park_Style. The style is saved in the directory specified in the MAPublisher Preferences.

Next, you'll create the rules for the Small Park label filter.

8. Beside the Rules drop-down list, click the Edit button to open the Area Rules dialog box.
9. In the Area Rules dialog box, in the Placement tab, click the Allow extending beyond boundary check box.
10. In the Fitting tab, for the Allow stacking rule choose Up to 4 lines from the drop-down.
11. In the Conflict Avoidance tab, In the Click the Allow use of leader lines check box and keep its default parameters.
12. Click the Allow labels to cross lines check box to disable the rule.

13. Click the Save button and in the Save Rule As dialog box, type Small_Park_Rules in the Name box and click Save.

14. In the Area Rules dialog box, click OK.

In the MAP LabelPro dialog box, the Rules drop-down list now displays Small_Park_Rules. The rule is saved in the directory specified in the MAPublisher Preferences.

15. Repeat the same process to setup the second label filter as Large Park. Choose a different font style and label color to help distinguish large parks from small parks.

Hint: Choose the same Style and Rules as Small Park label filter. However, edit the Small_Park_Style to change the font style and label color, then save it as Large_Park_Style.
4.4 Execute labeling with MAP LabelPro

1. Make sure that all the layers have been configured appropriately and click the Label button. The parks are labeled appropriately according to the style and rules defined in MAP LabelPro.

2. Click the MAPublisher Log button on the MAPublisher Toolbar.

Statistics about how many labels were placed (or not placed) on each layer are displayed in the log. Notice that the first labeling session is also listed.

3. After reviewing the statistics, close the MAPublisher Log dialog box.
Congratulations, you have completed the MAPublisher 9.5 MAP LabelPro tutorial. For more in-depth information on MAPublisher tools and features, please take a look at the MAPublisher 9.5 User Guide, MAPublisher 9.5 Tutorial Guide and Quick Start Guide. These documents are installed with MAPublisher or can be downloaded from http://www.avenza.com/documentation.